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1. Revision History 

 

Revision 

Number 

Details Date 

1.0 Initial Version  7 Aug 2007 

1.1 RS485 connector pin chart changed (Page 5) 17 Jan 2008 

1.2 Updated “Displaying NTCIP Objects on Web Pages” 24 Jun 2008 

1.3 Update default parameter details 03Mar2010 
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2. Overview 

The IDI 1600 Series of NTCIP Field Device Controller is one of a family of controllers designed by 
Intelligent Devices for use in real-time control of Intelligent Transportation System devices.   
 
The base model, the 1600, includes the following features: 

• Dual processors 

• Support for keyboard and LCD for local menu interface 

• Two RS-232 serial ports 

• Two RS-232/RS-485 jumper-selectable serial ports 

• Eight digital inputs 

• Four analog inputs 

• Four digital outputs 

• Battery-backed RAM and real-time clock 
 
The 1620 and 1621 models add 16MB of non-volatile FLASH memory, allowing for download and 
serving of web pages with appropriate firmware.  The 1601 and 1621 models add an Ethernet port, 
allowing for communications over a standard 10Base-T Ethernet network. 
 

3. Features 

Refer to IDI 1600 Controller - Parts Locations at the end of this document for a pictorial 
representation of the locations of the controller parts referenced in the following sections. 

3.1. Power 

The 1600 board receives power through J1.  The board accepts 9-30 volts, either AC or DC.  
Jumper JMP1, located near J1, should have the jumper set to the proper position based on whether 
AC or DC is being applied to J1.  Pin 1 (square solder pad on bottom of board) is AC Neutral or DC 
negative.  Pin 2 is AC live or DC positive.  The board draws no more than 1 amp. 

3.2. LEDs 

The board has five LEDs located on the motherboard, labeled LED1 through LED5.  LED1 is the 
Main Processor Heartbeat LED, and will blink at a steady rate whenever the Main Processor is 
operating properly.  The operation of LED2 through LED4 will vary based on the firmware loaded 
into the Main Processor.  LED5 will blink at a steady rate whenever the Menu Processor is 
operating properly. 

3.3. DIP switches 

The DIP switches (S1) perform multiple functions.  If all DIP switches are set to their OFF positions, 
and power is cycled or the RESET button is pressed, upon powering up the Main Processor will 
clear all of its memory and return all parameters to their factory default values.   
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Most firmware uses the DIP switches to set the serial communications address.  Refer to Section 
4.2, Setting the Serial Communications Address, for details of how to set this address. 
 
Models 1601 and 1621 support Ethernet communications, and use the DIP switch address for the 
default IP address.  Refer to Section 4.3 - Setting the Ethernet IP Address, below for details of 
setting the Ethernet communications parameters. 

3.4. Serial Communications 

Refer to IDI 1600 Controller – Cable Connector Details at the end of this document for details of 
the connector pinouts. 
 
The 1600 series controllers support two RS-232 serial ports, and two RS-232 / RS-485 selectable 
serial ports.  The table below indicates the names for the ports, the connectors that each port is 
associated with, the jumpers that must be set to select between RS-232 and RS-485 for the two 
selectable ports, and the jumpers used to terminate the RS-485, if necessary.   

 
Port AKA RS-232 

Connector 
RS-485 

Connector 
RS-232/RS-485 

Jumpers 
RS-485 

Terminators 

Port 0 Port C P1 J3 JMP6 JMP2-5 
Port 1 Port B P2 J6 JMP11 JMP7-10 
Port 2 Port D P3 n/a n/a  
Port 3 Port A P4 n/a n/a  

 
The RS-232 connectors P1 through P4 are DB9 male connectors configured as DTE, meaning a 
null modem cable is required to connect these ports directly to a DB9 male serial port on a 
computer.  The pinout is as follows: 

 
Pin Signal Name Signal Description 

1 DCD Data Carrier Detect 
2 RXD Receive Data 
3 TXD Transmit Data 
4 DTR Data Terminal Ready 
5 SG Signal Ground 
6 DSR Data Set Ready 
7 RTS Request To Send 
8 CTS Clear To Send 
9 RI Ring Indicator 

 
 

The RS-485 connectors (J3 and J6) support four-wire communications.  To connect one of the RS-
485 ports to a two-wire network, simply jumper TX+ to RX+ and TX- to RX-.  The pinout for each 
port is as shown in the following table.  Pin 1 is located farthest counter-clockwise when the board 
is viewed from above, and can be identified from the bottom of the board by its square solder pad. 

 
Pin Signal Name Signal Description 

1 SG Signal Ground 
2 TX+ Transmit Positive 
3 TX- Transmit Negative 
4 RX- Receive Negative 
5 RX+ Receive Positive 
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The function and communications parameters of each serial port vary based on firmware, but Port 2 
typically supports PMPP NTCIP communications at 9600 baud, with 8 data bits, no parity and 1 
stop bit. 

3.5. Analog Inputs 

The 1600 supports four analog inputs, routed to the controller via connector J5.  The inputs are on 
pins 2 through 5, with pin 1 being signal ground, and pin 6 being +5VDC routed through a 10 ohm 
resistor (R21).  The inputs are rated for voltages from 0 to +5VDC, and have a 24k +/-1% input 
impedance.  Full scale input is 4.8VDC +/- 0.2VDC, resulting in a full-scale reading of 4800. 

3.6. Digital Inputs 

The 1600 supports eight digital inputs, routed to the controller via connector J4.  The inputs are on 
pins 1 through 8, with pin 9 being signal ground, and pin 10 being +5VDC routed through a 10 ohm 
resistor (R79).  The inputs are rated for voltages from 0 to +5VDC, with a nominal switching 
threshold of 2.5VDC. 

3.7. Digital Outputs 

The 1600 supports four digital outputs, routed from the controller via connector J2.  The outputs are 
on pins 2 through 5, with pin 1 being signal ground, and pin 6 being +5VDC routed through a 10 
ohm resistor (R62).  The outputs are open-drain, low-true, and are rated for 100mA.  J2 pin 1 
should be connected to the ground of the devices being switched to prevent excess current from 
being conducted across the traces of the controller. 

3.8. LCD 

FEMA Electronics GM24064B-SGT2CLY-BKZ 
 
The LCD as received from the manufacturer requires the addition of a shrouded ribbon header and 
a two-pin connector for the backlight. 
 
The LCD connects to the IDI 1600 card with a 20 conductor ribbon cable.  Backlight power is 
included in this ribbon cable, but the FEMA Electronics LCD requires a separate backlight cable 
that attaches to the two-pin J11 connector of the IDI 1600.  Note that the LCD must be plugged in 
before the controller is powered on for it to work properly 

3.9. Keyboard 

Any IBM-compatible keyboard with a PS-2 connector may be used.  The PS-2 connector plugs 
directly into the IDI 1600 card at J13. 

3.10. Radar Option 

If supported by firmware, the controller can be interfaced to a Decatur SI-2 radar unit to 
automatically monitor traffic speed.  The SI-2 should be configured according to the following table.  
To configure the SI-2, you will need: SI-2 RS232 programming cable; SI-2 configuration software 
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(SI2D Config v1.7.exe); 12V power supply with a power switch; and SI-2 Configuration Instructions 
found in the file: SI2ConfigurationInstructionsRev07_02.pdf. 

 
Parameter Value 

Speed Setup MPH 
Sensitivity Value 17 
Update When Speed 
Changes: 

Max 

Override Update Rate 
with updates... 

UNCHECKED (not selected) 

updates every 3 1/10 seconds. 
Data Hold Time 2 
Low Speed Cutoff 5 
High Speed Cutoff 200 
Cos Correction 1 0 
Cos Correction 2 0 
Report Approach Targets 
Baud Rate 9600 
Direction Report UNCHECKED (not selected) 
TX String 8n1 ASCII <D>[SSS.] <CR> 
Poll String 8n1 ASCII ['*P']<CR> 

3.11. Photocell Option 

Many Dynamic Message Sign applications use the optional Intelligent Devices photocell.  The 
signals associated with the photocell wires are: 
 

Orange – to 5V 
Blue – to GND 
White – signal 

 
White is from the white/blue pair; the white from the white/orange pair is not used. 
 
The photocell typically connects to the IDI 1600 card analog input 0 (J5 pin 5). 

3.12. GPS Option 

The GPS option allows the controller to receive location information from a small Global Positioning 
System sensor.  The sensor receives timing information from multiple satellites located in low Earth 
orbit (LEO).  Location information can be retrieved from the controller using NTCIP objects 
essLatitude and essLongitude.  If the controller firmware supports WebDirectTM, the location 
information can automatically be transferred to a map website such as Google maps, where the 
user can then view the location from varying zoom levels on a street map, a satellite map, or a 
hybrid of both maps. 
 
Note that the GPS satellite radio signals do not travel through objects, so the system will only return 
valid location information if it has a direct line of sight to multiple satellites.  For this reason, the 
GPS system will not work inside a building, and may experience periods when no valid location 
information is available.  If valid location information is not received, the controller will return 
essLatitude = 90.000001 and essLongitude = 180.000001. 
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The GPS unit is a Garmin GPS18LVC. 

 
Distributor: Navtech GPS 

Suite 230 
5501 Backlick Road 
Springfield, VA  22151 
 (703) 256-8900 / (703) 256-8988 (fax) 

 
The GPS connects to the IDI 1600 via a DB9 connector that requires 5V to power the unit.  A ribbon 
cable is used to inject the 5V from the Digital Out port of the 1600 (J2). 

 
Reference IDI drawing 223-0001, “Garmin GPS 18LVC Wiring Diagram” 

3.13. Ethernet Communications 

The Model 1601 and 1621 controllers have an Ethernet port located on the Main Processor Board 
which supports Ethernet communications, and web-based communications if supported by the 
firmware.  The NTCIP Ethernet communications is configured to support SP-Ethernet using UDP/IP 
on Port 300.  Communications using NTCIP requires the use of an NTCIP-compliant central such 
as Intelligent Devices’ Intelligent Control.  Note that the controller does not support PMPP over 
Ethernet, so communicating to the controller using a serial-to-Ethernet converter or a serial port 
capture program such as COM IP is not supported.  Refer to Section 4.3, Setting the Ethernet IP 
Address, for details of configuring the Ethernet communications parameters. 
 
If the WebDirectTM option is supported by the firmware, the controller will have the ability to serve 
web pages over the Ethernet port.  Communications to the controller requires only an Internet 
browser such as Microsoft Internet Explorer. 

4. Configuring the Controller 

4.1. Controller Firmware Update Procedure 

The Controller Firmware can be updated in the field using a Rabbit programming cable, Rabbit 
Field Update software, and a computer running Windows.  A Field Upgrade Kit, consisting of the  
Rabbit programming cable, Field Update software, and instructions, is available from Intelligent 
Devices. 
 
Programming the Main Processor: 
1) Apply power to the IDI Controller. 
2) Connect the DB9 end of the programming cable to an IBM-compatible computer. 
3) Connect the 10-pin plug of the programming cable that is labeled “PROG” to the 10-pin header 

on the Main Processor board.  The red stripe on the cable should be aligned with the cutout 
corner of the silkscreened decal surrounding the 10-pin header on the processor board. 

4) Start the Rabbit download utility by double-clicking the RFU.EXE file.  Select File->Load Flash 
Image..., then browse to the provided Main Processor firmware file.  The file will have a “.bin” 
extension, and will be the larger of the two files for the 1600.  Once selected, click the OK button 
to start the download. 
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Programming the Menu Processor: 
5) When the download finishes, move the 10-pin connector from the Main Processor board to the 

Menu Processor Board.  Align the red stripe on the cable with the white triangle on the 
silkscreen. 

6) In the Rabbit download utility, select File->Load Flash Image..., then browse to the provided 
Menu firmware file.  The file will have a “.bin” extension, and will be the smaller of the two files 
for the 1600.  Once selected, click the OK button to start the download. 

7) Upon completion of the file download, remove the programming cable from the Menu Processor 
board and press the reset button or cycle power on the controller.  LED4 (the one closest to the 
board edge) should come on steady for a few seconds while the translator reinitializes its 
memory.  Wait for LED1 to start blinking to indicate that the processor is running properly. 

 
NOTE: When a new version of firmware is loaded into the Main Processor the controller will clear its 
memory, and all settings will revert to factory defaults.  If the controller being programmed has 
Ethernet and an alternate IP address has been programmed, it will need to be reloaded.  See 
Section 4.3, Setting the Ethernet IP Address, below for details. 

4.2. Setting the Serial Communications Address 

Most firmware uses the DIP switches to set the PMPP communications address.  This is the 
address that is used when communicating with the controller via NTCIP over any of the RS-232 or 
RS-485 serial ports.  The address is set in binary, with each switch being assigned a value as 
follows: 

 
DIP Switch Address Settings 
 

Switch Value 
1 1 
2 2 
3 4 
4 8 
5 16 
6 32 
7 64 
8 128 

 
For any switch that is closed, the value associated with that switch is added to the Address.  For 
example, closing switches 3 and 5 will result in the address being set to 20 (switch 3 = value 4; 
switch 5 = value 16; 4 + 16 = 20).  In this way, addresses from 1 to 255 can be set.  Note that some 
firmware use switches 7 and 8 for configuration purposes; in these systems, the maximum address 
that can be set is 63. 

 
Once the desired address has been set on the DIP switches, power to the controller should by 
cycled, or the RESET button pressed, to have the controller read and apply the new address. 

4.3. Setting the Ethernet IP Address – 1601 and 1621 only 

Model 1601 and 1621 Controllers support NTCIP communications via Ethernet over the RJ-45 jack 
on the Main Processor board.  Upon first being powered up after initializing its memory, the 
controller sets its IP address to 192.168.1.x, where x is replaced by the address set on the DIP 
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switches.  This can be modified using the IP Set Utility, but it will revert back to the default address 
plus the DIP switch address after: a) powering up with all DIP switches set to 0; b) loading new 
firmware into the Main Processor; or c) losing power from the battery. 

 
The IP Set utility can be used to set the IP parameters of the controller, or to read the parameters, 
or to read the software version in the controller.  When run the utility looks like this: 

 

 
 

First, select the Comport No. from the drop down menu.  Connect a null modem cable between the 
PC com port and the controller’s P1 connector.  Enter the Device Address (set by the controller 
card DIP switches) at the top of the IP Set window. 
 
Click “Get Module Info” to verify the connection and the software version loaded into the translator.  
The table should fill in with data, and the second line should show the software version.  Click on 
the “Get” button to see the IP address currently programmed into the translator. 
 
To set an IP address, select the IP Address type as Static, enter the Subnet Mask and Gateway 
and Port number, and enter a unique IP Address for this translator.  The DNS server address is not 
used and can be left zeroes. 
 
NOTE: After setting the IP address, the controller must be reset or power-cycled before it will begin 
to use the new IP address. 
 
For communications using an Ethernet cellular modem, the IP address should be set to 192.168.1.1 
and the modem should be set to forward all traffic to that address.  The modem’s local address can 
be any compatible subnet address (192.168.1.2 … 192.168.1.254). 
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Any time a different firmware version is loaded, at the next power up the translator will re-initialize 
its memory and the IP settings will have to be reprogrammed. 
 

5. Configuring the Controller - WebDirectTM Option 

WebDirectTM is an option that allows a user with access to the web to monitor and control the device 
attached to the 1621.  This firmware option is only available with 1621 controllers, as the web pages 
are stored in the FLASH memory and accessed using http over the Ethernet port. 

5.1. Downloading Web Pages and XML Files 

Web pages and XML files can be downloaded to the controller using FTP (file transfer protocol) 
software such as FlashFXP.  A typical session would go as follows: 
 
1. Verify that you have a valid connection to the device.  To connect to a controller using Ethernet, 

connect a crossover cable between the computer and the controller.  Alternatively, a standard 
Ethernet cable can be used with a hub or switch to allow a connection to the controller.  Cycle 
power to the controller to ensure that the Ethernet interface on the controller is properly 
configured.  If properly configured, the green LED labeled DS1/LNK next to the Ethernet 
connector will be lit. 

2. Verify that the computer is configured to have a static IP address.  Refer to Section 5.3, 
Changing Computer IP Settings, for information on configuring your computer to have a static IP 
address. 

3. Open FlashFXP.  The left-hand window shows the files on the computer.  The right-hand window 
will be used to show the files on the controller. 

4. To connect to the controller, click the Lightning Bolt icon, then select Quick Connect.  On the 
General tab, enter the IP address of the device in the “Server or URL:” field.  For devices 
connected by a wireless modem, this will be the IP address of the wireless modem.  The IP 
address will be in the form of four numbers from 1 to 255 separated by periods (e.g., 
192.168.1.1).  Next, enter the User Name and Password for the device and click the Connect 
button.  You should contact Intelligent Devices for help if you have forgotten your password.  The 
right-hand window should now show the files that are pre-programmed into the controller, along 
with the A: folder.  If the A folder is not shown, press the Refresh icon above the right-hand 
window. 

5. Double-click on the A folder.  This is where the user-downloadable web pages are stored.  Click 
on one of the files, then hit Ctrl-A to select all files.  Locate the LICENSE.XML file, hold down the 
CTRL key, and click on the file to deselect the file.  Press the Delete key to delete all the files 
except the LICENSE.XML file.  Do not delete the file named LICENSE.XML, as this file enables 
the WebDirectTM function on the computer. 

6. In the left-hand window will be seen the files available for download from the computer.  Use the 
browse controls to reach the directory where the web files to be transferred are located.  Select 
the files to be transferred from the computer in the left-hand window using the cursor along with 
the Shift and Ctrl keys.  To select all files, press Ctrl-A.  Once all files have been selected, click 
the “Transfer Selected” icon above the left-hand window.  The files should be transferred to the 
controller, and appear in the right-hand window. 
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5.2. Displaying NTCIP Objects on Web Pages 

Using WebDirectTM, it is possible to display any NTCIP object on a web page without having to modify 
the firmware.  This function is performed through the use of XML files that can be downloaded to the 
FLASH memory on the 1621.  First, the NTCIP object must be referenced in the file VARLIST.XML.  A 
sample section of the file is listed below: 
 
  <auxIOValue>1.3.6.1.4.1.1206.2.1.1.3.1.5.2.1<t>2</t></auxIOValue> 

  <dmsSignType>1.3.6.1.4.1.1206.4.2.3.1.2<t>10</t></dmsSignType> 

  <currentmsg>1.3.6.1.4.1.1206.4.2.3.5.8.1.3<t>8</t></currentmsg> 

  <shortErrorStatus>1.3.6.1.4.1.1206.4.2.3.9.7.1<t>3</t></shortErrorStatus> 

 
Each line begins with a name tag enclosed in a left and right arrow.  For example, the second line 
above defines the variable “dmsSignType”.  Following the name tag is the OID, as defined in the NTCIP 
standard documents.  After the end of the OID, a tag <t> is placed to indicate the type of the object.  In 
this case, the type is 10, ENUM.  The types supported are as follows: 
 

 1 BOOLEAN 

 2 INT1, INT2, INT4, SIGN_INT1, SIGN_INT2, SIGN_INT4 

 3 BIT STRING (1 based, i.e., for bit 0, use 1; uses ENUMS.XML) 

 Objects of this type must be referenced using one of the bit-based 

references listed below: either no indexes and a bit number, or two 

indexes and a bit number. 

 4    OCTET 

 5    NULL 

 6 OID 

 7 OBJECT DESCRIPTION 

 8 MESSAGE MULTI STRING 

 9 REAL 

10 ENUM (uses ENUMS.XML) 

16 Sequence 

17 Set 

18 Sequence of 

93 Reg point 

96 Owner string 

97 Display string 

98 Opaque 

99    COUNTER 

100 IP Address 

101 Message ID code 

102 Message Activation Code 

103 Position reference 

104 Date/time – converts the time in seconds to the US format: 

 month day, year HH:MM:SS 

105 volts – divides the voltage by 100 and will then convert the 

 result to the ASCII form: “nnn.mm V”. 

106 Latitude and longitude – Format GPS latitude or longitude into  

 an ASCII decimal string: 34.5678 or -80.1234 

107 Temperature – displays deg C and deg F 

 
After the type come the end tags for type and name, which are indicated by a forward slash followed by 
the tag. 
 
Objects of the type ENUM are stored as numbers, but have text strings associated with each number.  
A separate file, ENUMS.XML is used to define the text strings to be used for each value of each object.  
For the object dmsSignType defined above, the ENUMS.XML file shows: 
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 <dmsSignType> 

  <t1>Other</t1> 

  <t2>BOS</t2> 

  <t3>CMS</t3> 

  <t4>VMS Character Matrix</t4> 

  <t5>VMS Line Matrix</t5> 

  <t6>VMS Full Matrix</t6> 

  <t129>Portable Other</t129> 

  <t130>Portable BOS</t130> 

  <t131>Portable CMS</t131> 

  <t132>Portable VMS Character Matrix</t132> 

  <t133>Portable VMS Line Matrix</t133> 

  <t134>Portable VMS Full Matrix</t134> 

    </dmsSignType> 

 
Note that, similar to the tags in the VARLIST.XML file, all entries in the ENUMS.XML file have a start 
tag and an end tag. 
 
The web pages reference objects by use of the #echo directive, as shown in the example below: 

 

<p class="item">Sign Type:</p> 

      <p class="celldata" id="txversion"><!--#echo oid="dmsSignType" --></p> 

 

To reference the fan failure bit in shortErrorStatus, use the line below.  The ENUM associated with this 
object would then only reference values of 0 or 1, based on whether bit 11 is clear or set.  Note that bit-
string objects are limited to 16 bits. 
 
<!--#echo oid="shortErrorStatus_0_0_11" --> 

 
              Accepts name and index options as follows: 
                  name  -> name without any index 
                  name_1          -> name with one index 
                  name_1_2        -> name with two indexes 
                  name_1_2_3      -> name with two indexes and a bit number (1-based) 
                  name_0_0_1      -> name with no indexes and a bit number (1-based) 
 

After VARLIST.XML, ENUMS.XML and any web pages have been modified, they must be transferred 
to the FLASH drive on the 1621 card as described in Section 5.1 – Downloading Web Pages and XML 
Files.  Power to the controller must then be cycled to have the controller read the new files. 

5.3. Changing Computer IP Settings 

Setting a Static IP Address 
 
To connect directly to the controller using a crossover cable, the computer must be set to use a 
static IP address using the following steps: 
 
1. Click on Start, then select Control Panel.  From the Control Panel window, select Network 

Connections, then Local Area Connection.  On the General tab, select Internet Protocol, then 
click the Properties button. 

2. On the General tab, click the “Use the following IP address” radio button.  Under IP address, 
enter 192.168.1.3.  The Subnet Mask will automatically change to 255.255.255.0, which is fine.  
Click the OK button to accept the IP address. 

3. Click the Close button to close the Local Area Connection Properties window. 
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Automatically Obtaining an IP Address 
 
The computer can be set to automatically obtain an IP address from a DHCP server on the network 
by using the following steps: 
1. Click on Start, then select Control Panel.  From the Control Panel window, select Network 

Connections, then Local Area Connection.  On the General tab, select Internet Protocol, then 
click the Properties button. 

2. On the General tab, click the “Obtain an IP address automatically” radio button.  Click the OK 
button to accept the change. 

3. Click the Close button to close the Local Area Connection Properties window. 

6. Communicating with the Controller 

6.1. Communicating with the Controller via the Serial Ports 

The serial ports of the controller that have been configured to support NTCIP communications use 
PMPP.  An NTCIP-compliant central such as Intelligent Devices’ Intelligent Control is required to 
communicate to the controller using these ports.  To connect a computer directly to one of the RS-
232 serial ports, use a null modem cable with two female ends.  P1 is typically configured as a port 
that supports NTCIP, and is configured for 9600 baud, with 8 data bits, no parity, and 1 stop bit.  
Note that the PMPP address is set on the DIP switches as detailed in Section 4.2, Setting the Serial 
Communications Address. 

6.2. Communicating with the Controller via the Ethernet Port 

Model 1601 and 1621 controllers have an Ethernet port which supports NTCIP communications.  
An NTCIP-compliant central such as Intelligent Devices’ Intelligent Control is required to 
communicate to the controller using these ports.  A crossover cable is used to connect a computer 
directly to this port, or the controller can be connected to a hub or switch using a standard cable.  
The controller will then be accessible at the IP address that was previously set on the DIP switches 
or was set as detailed in Section 4.3, Setting the Ethernet IP Address.  The Transport Type should 
be set to UDP/IP, and the Server Port Number should be set to 300.   
 
NOTE: when using Intelligent Devices’ Intelligent Control or DeviceTester the Device Address 
setting in the computer software should be set to 0. 

6.3. Communicating with the Controller using WebDirectTM 

If the firmware supports WebDirectTM, the user can access the controller via the Ethernet port using 
a web browser such as Internet Explorer. 
 
Before accessing the controller, Internet Explorer should be configured to properly retrieve the web 
pages. 
 

1. Open Internet Explorer.  From the Menu toolbar, select Tools->Internet Options...  The 
Internet Options window will appear. 

2. Select the General tab.  In the Temporary Internet Files section, click on the Settings... 
button.  The Settings window will appear. 
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3. At the top of the Settings window, click the “Every visit to the page” button.  This will ensure 
that Internet Explorer will retrieve the most recent page available from the controller, rather 
than presenting a previous page that has been saved. 

 
Once Internet Explorer has been properly configured, to connect to the sign, simply type the IP 
address of the modem (e.g. 192.168.1.1) into the Address bar of Internet Explorer.  Internet 
Explorer will automatically place http:// before the IP address.  The sign will respond with a login 
screen: 

 

 
 
Type the User Name, press TAB, then type the Password and click OK. 
 
The controller will respond with the Main Menu web page, which will vary based on the web site that 
has been downloaded to the controller. 
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7. Troubleshooting / FAQS 

Downloading firmware to the Menu processor fails? 
 
If the Main Processor does not have a good version of code loaded, it may reset, which will result in its 
resetting the Menu Processor.  If the Menu Processor is reset during firmware download, the Rabbit 
Field Utility will indicate an error and stop.  To prevent the Main Processor from resetting the Menu 
Processor, hold down the RESET button during the Menu Processor firmware download. 
 
Why did the controller lose all its information/settings/messages? 
 
On a power up or reset, the controller will reinitialize its memory (and lose all downloaded messages) in 
these cases: 

1) DIP switches are all off (address is zero) 
2) The software version number is different since last startup (new code downloaded) 
3) The database checksum is bad (usually caused by a dead battery) 

  
Note that just changing the address on the DIP switches won’t reinitialize the controller (unless they are 
set to zero at power up). 
 
The controller does not respond to communications over an RS-232 serial port. 
 

1. Verify that the cable is the correct type.  For connecting a standard PC to the controller, a null 
modem cable should be used. 

2. Verify that the jumpers for the port are set to RS232.  Refer to Section 3.4 – “Serial 
Communications” for details of the jumper settings. 

3. Verify that the PMPP address is properly set on the DIP switches.  Refer to Section 4.2 – 
“Setting the Serial Communications Address” for details. 

4. Verify that the serial port supports NTCIP communications. 
5. Verify that the communications settings are correct for the serial port.  The parameters are 

typically 9600 baud, 8 data bits, no parity, and 1 stop bit, but these can be different in custom 
firmware.  

 
The controller does not respond to communications over an RS-485 serial port. 
 

1. Verify that the jumpers for the port are set to RS485.  Refer to Section 3.4 – “Serial 
Communications” for details of the jumper settings.   

2. Verify that the PMPP address is properly set on the DIP switches.  Refer to Section 4.2 – 
“Setting the Serial Communications Address” for details. 

3. Verify that the serial port supports NTCIP communications. 
4. Verify that the communications settings are correct for the serial port.  The parameters are 

typically 9600 baud, 8 data bits, no parity, and 1 stop bit, but these can be different in custom 
firmware.  

 
The Ethernet DS1/LNK LED does not light. 
 

1. Verify that the proper cable is being used.  For connecting a PC directly to the controller, a 
crossover cable should be used.  When connecting the controller to an Ethernet hub or switch, a 
straight cable should be used. 
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2. When connecting to the controller directly from a computer using a crossover cable, the 
computer must be set to use a static IP address.  Refer to Section 5.3 – “Changing Computer IP 
Settings”. 

 
The controller does not respond to communications over the Ethernet port. 
 

1. Verify that the DS1/LNK LED next to the Ethernet jack is on.  If this LED is not on, the controller 
is not properly connected to an Ethernet network.  Refer to “The Ethernet DS1/LNK LED does 
not light” above for details of troubleshooting this problem. 

2. Verify that the IP address is properly set.  Refer to Section 4.3 – “Setting the Ethernet IP 
Address” for details of how to determine and modify the IP address. 

3. Verify that the DC power to the controller is 12VDC or higher.  The Ethernet option may not 
operate properly at lower voltages. 

4. Ping the controller to verify proper communications.  From a PC, go to Start->Run.  Type “cmd”, 
then press the OK button.  A DOS window will appear.  At the prompt, type ping <IPADDR>, 
then press <Enter>.  <IPADDR> is to be replaced by the IP address, e.g. 192.168.1.1.  The 
window will indicate “Pinging 192.168.1.1 with 32 bytes of data:”  If the communications is 
successful, there will be four responses showing the time required to respond: “Reply from 
192.168.1.1: bytes=32 time=3ms TTL=64”, followed by a summary of the results of all four 
requests.  If the communications is unsuccessful, the window will indicate “Request timed out”, 
followed by the summary. 

5. Verify that the NTCIP Central software is using SP-Ethernet, rather than PMPP over Ethernet.  
With Intelligent Devices’ Intelligent Control and DeviceTester software, this is done by ensuring 
that “CDPD Mode” is not selected for the Connection Type. 

6. When using Intelligent Devices’ Intelligent Control or DeviceTester software, verify that the 
Device Address is set to zero (0). 

 
The readings from the Analog Inputs (battery voltage, AC voltage, photocells) are low. 
 
JMP1, the AC/DC selector, is in the AC position.  In this position, a diode is placed in the ground path of 
the incoming power, resulting in a voltage drop.  If the board is being powered from a DC voltage 
source, place the jumper in the DC position and the problem will be corrected.  If the board is being 
powered from an AC voltage source, make sure that it is an isolated source (such as a transformer that 
does not have its output referenced to its input), and then connect the ground reference for the system 
to the ground pin on the Analog Input connector (J5 pin 1). 
 
Using WebDirectTM, the only page that is displayed shows “Web services not enabled.” 
 
If the firmware loaded on the controller supports WebDirectTM, it will check the FLASH A: driver for a file 
named LICENSE.XML to determine if WebDirectTM is enabled.  This file is unique to each controller, 
and must be present for web services to function. 
 
Using WebDirectTM, permanent messages are displayed as “P001”, “P002”, etc. 
 
The controller defaults to these values until the permanent messages are loaded from the 
PERMMSGS.XML file. 
 

1. Reload the messages from the file by performing a hard initialization.  Set all the DIP switches 
to OFF, then press the RESET button.  The firmware will then load the permanent messages 
from the PERMMSGS.XML file.  When LED4 turns off, set the address on the DIP switches, 
then press the RESET button.  The permanent messages should now be loaded properly. 
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8. Specifications 

8.1. Hardware 

Module Size (overall, including connectors) 8.2” x 4.8” x 1.2” 
 208mm x 122mm x 30mm 
Attachment Qty 6 0.156” (4mm) holes 
Operating Temperature: -40C to +74C 
Humidity 5-95% non-condensing 
Power Requirements 9-30 V AC or DC 
Digital I/O 8 inputs 
 4 outputs 
Analog Inputs 4 inputs – 12 bit accuracy 
Processor Speed 22.1 MHz 
SRAM 512 kB (standard) 
FLASH 512 kB (standard) 
FLASH Memory (1620, 1621 models only) 16 MB data storage 
Serial Ports 5 total 
 3 – RS232 full hardware flow control 
 2 – RS232 full hardware flow control 
 or 4-wire RS485 
Watchdog Supervisor Yes 
Time / Date Clock Yes 
Battery Backup Yes 
Temperature Sensor Yes 
Keyboard Port PS/2 Standard 
 RS232 Optional 
LCD Port 240 x 64 Graphics with integrated 
 backlight control 
LED 4 – Heartbeat, RX, TX, Diagnostics 
 (Main) 
 1 – Heartbeat (Menu) 
Switches Reset 
 8 Position DIP 
Ethernet (1601, 1621 models only) 10BaseT with 2 diagnostic LEDs 
Modem (optional) Not recommended for new design 
 

8.2. Software 

Protocol Stacks Supported 
Direct Connect Data Objects -> SNMP -> Null -> PMPP -> Twisted Pair 
Ethernet Data Objects -> SNMP -> UDP/IP -> Ethernet 
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IDI 1600 Controller - Parts Locations 

Optional 
Ethernet 
connector 

Digital 
inputs 

Analog 
inputs 

Menu 
Processor 
Heartbeat LED 

LCD 
connector 

Port 0 
RS232 

Port 1 
RS485 

Port 3 
RS232 

Port 1 
RS232 

Digital 
outputs 

Menu 
Processor 
Board 

Main 
Processor 
Board 

Power 
9-30V 
AC/DC 

Port for PS2 
keyboard 

Port 0 
RS485 

Port 2 
RS232 

Port 0 
Jumpers 

Port 1 
Jumpers 

Programming 
Header Pin 1 

Programming 
Header Pin 1 

DIP 
switches 

AC/DC 
Jumper 
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IDI 1600 Controller – Cable Connector Details 
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IDI 1600 Controller - Physical Dimensions 
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GPS Sensor Wiring Diagram 




